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Cisco 300 Series Solution Overview

When you need advanced features and network management, but value is still a top priority, look to
the Cisco 300 Series switches.

The Cisco 300 Series, part of the Cisco Small Business line of network solutions, is a portfolio of
affordable managed switches that provide a reliable foundation for a small business network. With 8
to 48 ports of Fast Ethernet (including 2 or 4 Gigabit Ethernet uplinks) or 10 to 52 ports of Gigabit
Ethernet connectivity, plus Power over Ethernet (PoE) options, these switches offer a comprehensive
range of choices. The Cisco 300 Series Managed Switches deliver the advanced security, quality of
service (QoS), energy-saving technology, and network features needed to support business-class data,
voice, security, and wireless solutions. They are easy to configure and manage, include a limited
lifetime warranty with next business day advance replacement (where available) and one year of
technical phone support. The Cisco 300 Series Managed Switches provide the ideal combination of
ease-of-use, affordability, performance, and capabilities in a solution designed specifically for small
businesses.

Cisco 300 Series Demo Guide

This Demonstration Script is centered on the newly-released 300 Series Managed Switches — its
advanced feature set, QoS capabilities and ease-of-use. The 300 Series makes it easy for Small
Businesses to manage their network, build a new network, or expand an existing one, with or without
a dedicated IT staff.

This document gives you the means to become more comfortable with the SG300 switch, and to help
you demo it in sales and training events.

This script is accompanied by matching Videos on Demand to help you prepare for your demos, which
can be found on the Cisco Support Community, along with SmartTips, Smart Designs, and other
valuable information on Cisco’s 300 Series switches. Go to:
https://supportforums.cisco.com/community/netpro/small-business/switches?view=documents

There are 2 types of demonstrations in this document — Basic and Advanced.

The Basic demo gives instructions on how to demonstrate the Management interface, while keying in
on feature highlights. The Advanced demo gives instructions on how to demonstrate a working
solution in real time.

All through the demonstration, we focus on the following items:

* Intuitive Graphical User Interface (GUI)
* Ease of Configuration
* Cost savings for the Small Business:



o Future proofing with IPv6
o Power Optimizations (also known as Green Ethernet)
* Advanced Feature set compared to similar products (shown in Advanced Demo)

Demonstration Script Key

This demo provides a step-by-step guide to configuring various items in the switch.

STEP 1. Numbered instructions must be carried out in the order shown.
*  Bulleted features in each script can be selected individually for alternate views or testing.

%‘ Note Instructions worth noting!




Preparing for the Demo

Bill of Materials

The Basic demo requires the following devices:

e  Cisco 300 Series Switch — SG300-10P or SG300-28MP
*  Power Cord
*  Ethernet Cable that is less than 50 meters (164 ft.) long
¢ 1 PCwith the following software installed:
o Latest version of Internet Explorer or Firefox
o FindIT Small Business Toolbar — available at http://www.cisco.com/go/findit

The Advanced demo is more complex and gives a more realistic snapshot of a live network, with
multiple devices communicating and packets going through the switch. This set of demonstrations
would require additional equipment, as follows:

e Cisco 300 Series Switch — SG300-10P or SG300-28MP
*  Power Cord
*  Ethernet Cable
*  Serial Cable
* 2PCs:
o Management PC with the following software installed:
= Latest version of internet Explorer or Firefox
= VLC Video Media Player version 0.8.6h (go to www.videolan.org/vic/)

= FindIT Small Business toolbar — available at http://www.cisco.com/go/findit

o 1 other PC with VLC Video Media Player version 0.8.6h installed (included in package,
or go to www.videolan.org/vlc/. Used for Multicast Demo

* A DVD of your favorite movie — used for Multicast Demo

%‘ Note You can show the Advanced demos within the Basic form, by simply explaining
the solution you are configuring and walking through the configuration process




Getting Ready: The Night Before your Demonstration

1.

Make sure you are equipped with all the necessary items on the Bill of Materials, per the

scenario you will demonstrate.

Ensure that the latest version of Internet Explorer is installed on your PC.

. It is recommended to use Internet Explorer version 6.0 or later, and Firefox version 2.0 or
later.

Familiarize yourself with how to change the IP address on your PC, so that it can communicate

with the Switch. For more information and instructions on how to perform these functions on

MACs and PCs, please refer to the accompanying Videos on Demand. or refer to your OS Help.

*  The switch is preconfigured to 192.168.1.254, so you would need to ensure that your PC’s
IP address is in the 192.168.1.0 subnet (for example: 192.168.1.25)

Reset the switch to its Factory Defaults, to show a clean, out-of-the-box configuration

scenario.

* Todo this, insert a paper clip into the reset Button on the Front Panel of the Switch, and
hold it for 10 seconds. Or, enter the switch management page, and navigate to
Administration > Reboot and click on Reboot to Factory Defaults

Practice the demonstration scenarios a few times, so you get fluent with the demonstration

actions and be comfortable with talking to the many benefits of the 300 series to your

audience.

Device Setup

STEP 1.

STEP 2.

Plug the power cord to the Cisco 300 Series switch (power port is located at the back side of
the switch).

Connect the Ethernet Cable from the Ethernet port of your management PC to Port 1 of the
switch’s Ethernet Port. The LEDs on the connected Port should become green to indicate that
the Port is Operational.

Port 1 is given as an example, but you can alternatively connect the cable to any other port
on the switch.



Your network Topology should look something like this:

“Basic” Demonstration Design Business

Management PC
192.168.1.25 ‘
255.255.255.0 L

300 Series Switch
192.168.1.254
255.255.255.0



Basic Demo

This set of demonstrations is centered on the basic configuration of the 300 Series Switch. It is
configured to out-of-the-box operation; however in many cases in real-world deployments, additional
settings will be required.

It is important to highlight and showcase the intuitive management interface, its ease-of-use and
aesthetics through your demonstration. This interface is common through not only the 300 Series
switches, but also across many other SBTG products.

This section will cover the following scenarios:

*  Gaining Access to the Switch

*  Viewing System Information

¢ Defining an Identity

*  Configuring the Management Interface, IPv4 and IPv6
*  Configuring additional User Accounts

*  Saving and Viewing the Switch Configuration

*  Viewing Cost savings due to Power Optimizations

*  Using the Robust and Efficient Help Options

Initial Setup: Gaining Access to the Switch
The Cisco 300 Series switch is accessible via the following options:

*  Web-based configuration GUI

*  FindIT — The Small Business Toolbar
*  Menu based Console

. Remote Management using SNMP

Here we will demonstrate the first two options, as these are the easiest and most accessible.

Scenario 1: Web-based Configuration GUI
STEP 1. The switch is preconfigured for IP address 192.168.1.254. Ensure that your PC’s IP address is
in the 192.168.1.0 subnet (for example: 192.168.1.25).
STEP 2. Start a Web Browser.
STEP 3. Enter the IP address of the switch (http://192.168.1.254) in the address bar.
STEP 4. When the login page appears, enter the user name and password; then click Login.

The default user name is cisco. The default password is cisco. Passwords are case sensitive.

% Note For security reasons you will be prompted to change your password. This will be
demonstrated in Scenario 1 of this document




STEP 5. Proceed to other Demo scenarios or utilize the Getting Started page to complete the Initial
Setup. This page offers links to common tasks to get the switch configured and operational
quickly.

STEP 6. You can also utilize the handy menu bar on the left hand side of the management web page
to access various configuration options. This menu bar will appear on every screen for easy
and quick navigation. We will access it throughout the Demo, so you become familiar with its
possibilities.

Status and Statistics

Getting Started

>
> Administration
* Port Management This page provides easy steps to configure your device
» VLAN Management
* Spanning Tree 2  Initial Setup ¢ QuickAccess
> MAC Address Tables Change Device IP Address Change Device Password
» Multicast
- Create VLAN Upgrade Device Software
» |P Configuration
> Security Configure Port Settings Backup Device Configuration
» Access Control Create MAC-Based ACL
> Quality of Service iilly Device Status Create IP-Based ACL
L SNME System Summary Configure QoS
Port Statistics Configure Port Mirroring
RMON Statistics
View Log
Other resources: Support| Forums
[~ Do not show this page on startup
% Note During the device settings process, it’s advisable to often Save your
configuration, to protect your settings in case of a sudden shutdown due to
power failure. You can do this on the upper right side of the screen as shown
below.
The system will indicate that changes were made and that saving your
configuration is required, by a red X sign next to the Save link.

Scenario 2: FindIT — The Small Business Toolbar

Cisco FindIT is a tool that allows you a safe and care-free management of your network.

It is free for download, and once installed on your PC, will automatically discover all supported Cisco
Small Business devices in your network, list them in the Device Discovery sidebar and provide quick
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access to them. This tool saves you the time in organizing the Devices are organized by device type
(router, switch, and so on).

* Toview device information, position your mouse over the device name.

* Tolaunch a device manager, double-click the device name.

% Note If you are running Internet Explorer on Windows Vista or Windows 7, you may
have difficulties using programs like Cisco FindIT that use pop-up windows.
Cisco FindIT uses a pop-up window to display its Help system. In addition, many
of the Cisco device managers use pop-up windows for configuration settings.

You can install, find documentation, and obtain support for the Cisco FindIT Small Business Toolbar at
the following location:

http://www.cisco.com/go/findit

STEP 1. From the FindIT Toolbar on the Internet Explorer window, the devices on your network will
appear on the left-hand side of the window.
Hovering over the switch icon will provide a quick description to its configuration.

2 Cisco Systems, Inc - Microsoft Internet Explorer, provided by Cisco Systems, Inc.

File Edit View Favorites Tools Help

@Back - & [i] @ h /,WSearch \if’/Favorites 63’ 8- /’. ] ~ _ ‘:;‘ ﬁ ‘3
Address ‘._é_'] http:f v, cisco.com

.ICII;C”O" LOFindT ~ = Applications ~ {3} Settings  ~ @ Support ~

FindIT X

alvadn
CISCO

Solutions Products & Services |

=8 Cisco Small Business

=l -Q)Router
router746054

1=~ Switch
switcheg55e3

| Wireles
i Model No: SF 300-48P
R Storage Device Type: Switch
Efrathg Description: 48-port 10/100 PoE Managed Switch
< Camers Firmware Version: 1.0.0.27
of 1 PID VID: SRW248G4P-K9 v01
MAC Address: 002584ES55E3
Serial Mo: DNI1423001C

; I |

Double click the link to the switch and the management Web GUI will appear. Proceed to configure it

just as in the previous section
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rosoft Internet Explorer provided by 0 Systems, Inc.

File Edit View Favorites Tools Help

Q- © REG P dorme @22 @ UPH B

Address @ http:{fswitcheSSSe3.local. fconfigflog_off_page.htm

"cll's'é';' LFindT  ~ = Applications ~ 494 Settings ~ @ Support ~

FindIT

N m ]
cisco FindIT

Switch
Description: 48-port 10{100 PoE Managed Switch Username:
Firmware Yersion: 1.0.0.27
PID VID: SRW248G4P-K9 V01
MAC Address: 002584ESSSE3
Serial No: DNI1423001C

ord

12



Scenario 3: Changing the Default Password

Once you are logged into the system, it is advisable to change the default password to protect its

access.

STEP 1.

STEP 2.

If this is your first time to log on, you will be prompted to change the default password.
Alternatively, you can reach this tool from the Getting Started page, by clicking Change
Device Password.

Apply your new password into the assigned spaces and save it for your records. Click
Apply to save your settings.

Change Password

Old Password: s

New Password: = |ssessssscsaccsnsee

Confirm Password:  [ssssssssssssasenes |

Password Strength Meter: [N N |

The default password should be changed.

. Apply

%‘ Note The Password Strength Meter will measure the password strength, that is, how

easy it is to hack it.
It is advised to enter a password that is not easy to hack, and contains many
different characters, such as uppercase and lowercase letters, numbers and
special characters.

Scenario 4: Viewing System Information

You can easily understand the state of the 300 Series switch, its key features, and view logs for

troubleshooting purposes.

Viewing the Status of the Switch

STEP 1.

STEP 2.
STEP 3.

STEP 4.

On the menu bar, choose the Status and Statistics tab and select System Summary. This
page shows key information about the switch and its ports.

Observe the picture of the switch, where you will see real-time status indication.

Notice the System LED on the left hand side of the picture. A green LED indicates that the
system is operational and up and running

Observe Port 1 (where your PC is connected). Notice that there are 2 figures for LEDs on
each port, just like on the switch itself.

The left LED indicates activity, and the right LED indicates PoE status

Notice that the left LED on that port is green, meaning that port is operational
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Accessing Port Status

Viewing information about a specific port is very intuitive from the Status and Statistics page that you

are already on.

STEP 1.

STEP 2.

In the Status and Statistics page, on the picture of the switch, double-click on the area of
Port 1. This will automatically open up the status and configuration page for this port,
where you can see connectivity status and edit various attributes of that port (such as
Auto negotiation, flow control, MDI/MDIX).

Alternatively, you can reach this page from the Port Management menu, in the Port
Settings page. Click on Port 1 radio button and click Edit.

% Note The 300 Series GUI is intuitively designed to link between pages that are

logically connected, and this is a common theme along the demonstration. In
the example here, you can reach the port status page via different alternatives.
However, you will find more examples as you run through the demonstration.

General Switch Information

General switch information is available on the Status and Statistics page.

Physical information can be viewed, as well as MAC address, Serial number, and also Firmware
Version. This information is useful for maintenance purposes, For example, to assess whether an
upgrade is on order.

Scenario 5: Defining an Identity
In order for your switch to be easily managed and discovered, you can give the switch an identity

providing a location, contact, and name.

STEP 1.
STEP 2.

STEP 3.
STEP 4.

On the menu bar, choose the Administration tab and select System Settings.

Apply a location (for example: Irvine, CA) and contact person (for example: your name)
for the switch. You can also change the host name to something that makes more sense
to the network (for example: IRV-SW1, indicating 1* switch in Irvine).

Click Apply to save your changes.

You will be prompted with a Success notification at the top of the screen, once this action
has taken effect.
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Getting Started
> Status and Statistics

System Settings

- -~ OV System Description: 10-port Gigabit PoE Managed Switch
* Management Interface

System Location: Irvine
User Accounts =
Idle Session Timeout System Contact: Rod Ormond
* Time Settings Host Name: Use default

» System Log * User defined [IRV-SW1

* File Management
Reboot

]| cancel

Scenario 6: Configuring IPv4 Settings

In order to easily manage the switch, it is important to configure its address such that it complies with
the network. The switch can get a dynamic IP address from a DHCP server on the network, or be
assigned a static IP address.

% Note The switch will default to get a dynamic IP address, however changing it to a
static IP address will give the network administrator more manageability

Here we will show how to apply a static IP address to the switch

STEP1. On the menu bar, from the Administration tab, choose the Management Interface tab
and select IPv4 Interface.

STEP 2. Change the IP Address Type to Static by clicking on the Static radio button.

STEP3. Apply an IP address and appropriate network mask.
In this demonstration we will remain with the default IP address 192.168.1.254, with a
24-bit subnet mask of 255.255.255.0.
No default gateway is required for this demo, so Default Gateway is None.

STEP4. For demo purposes, we want to ensure connectivity between the switch and your PC, so
do not apply these changes:
Click Cancel twice to disregard this configuration.
Or set the IP address to the default values as in Step 3 and Save.

Scenario 7: Configuring IPv6 Settings
IPv6 is the next generation Internet networking protocol and is intended to supersede the currently-
used IPv4 protocol, which is limited in address space and flexibility it provides.

Internet Service Providers, PC manufacturers, and government agencies worldwide are adopting IPv6
so this standard will be the de-facto standard in the upcoming years.
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The Cisco 300 Series switches already provide IPv6 capabilities, to provide scalability into future
network configurations, therefore providing future protection, and decreases cost of ownership.

%4 Note The 300 Series provides a Dual-stack mechanism, meaning it can translate
between IPv4 and IPv6, depending on the network, and thereby allowing a
healthy migration between the 2 standards.

The menu to configure IPv6 settings is available on the Administration tab, under Management
Interface, in multiple IPv6 configuration setting menus, as seen here.

More information can be found on IPv6 configuration in the Cisco 300 Series datasheet.

Getting Started
» Status and Statistics
v Administration

System Settings

v Management Interface
ntel

IPv6 Global Configuration
IPV6 Interface
IPv6 Addresses
IPv6 Default Router List
IPv6 Tunnel
IPv6 Neighbors
IPv6 Routes
wﬂ\um‘: )
Idle Session Timeout
Time Settings
System Log
File Management
Reboot
Diagnostics
Discovery - Bonjour
» Discovery - LLDP

S

v

Scenario 8: Configuring Additional User Accounts
Adding new users to manage your system is valuable to offload IT personnel, and to enable other
users to administrate the system, other than the default user. To do this, follow these steps:

STEP1. From the Getting Started page, click the Change Device Password.

Alternatively, you can access the same page through the Administration tab, on the User

Accounts link.
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STEP 2. You will see the default username, which is cisco. Checking that username, and clicking

Edit will enable you to modify the details of the default login. However it is not advisable

to do so, in order to maintain a known default username and login.

sTEP3. Click on the Add button. This will open up another window in which you will be prompted
to list the new user’s details.

STEP4. Enter a new username and a password which you will remember, and click Apply.

800

Add User Account

prt 10/100 PoE Manage’

) [ http://192.168.1.102/password/security_manage_localUsers_a.htm 1.7 )

User Accounts

User Name

[ cisco

Lo

% User Name:

Password:

—~ Confirm Password:

(0120 Characters Used) 4}
3 |

(0/64 Characters Used)

Password Strength Meter: [N ]

Em

Fnomy|[_cose |

<€

Scenario 9: Saving and Viewing your Configuration

During the device settings process, it’s advisable to often save your configuration, to protect your

settings in case of a power failure. Once you’ve applied changes to the switch, the system will indicate

that changes were made, and that saving your configuration is required, by a red X sign next to the

Save link.

Saving your Settings to Internal Memory

You can save your work, by clicking on the easy Save link on the upper right side of the screen as

shown below. This will direct you to the Copy/Save Configuration page, which you will utilize below in

the demonstration.

STEP1. On the menu bar, from the File Management tab, go into the Copy/Save configuration.
This will show you different options for saving your configurations.

STEP 2. We would like to save the Running configuration into the Startup configuration so the
switch would always start up with the changes we made.

Select Running Configuration from the Source File Name and Startup configuration from

the Destination File Name and click Apply.
This will save your changes to the internal memory of the switch.

Copy/Save Configuration

Source File Name:

Destination File Name:

® Running configuration
() Startup configuration
(O Backup configuration
(O Mirror configuration

@ Startup configuration
(O Backup configuration

|Apply-| [ cancel
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Saving your Settings to a Text Editable File

Additionally, you may save your configuration into an editable text file, on your PC.

This especially comes in handy when you need to apply common tasks to many switches on your
network.

STEP1. On the menu bar, from the File Management tab, go into the Download/Backup
Configuration/Log page.

STEP 2. Select HTTP as Transfer method, Save Action as Backup and Startup Configuration as
Source File Type.

STEP 3. Click Apply. This will trigger a popup to save the file to our PC’s hard drive.

STEP 4. You can open the file you just saved from a simple text editor to see the changes that you
made.

18



Green Ethernet

The Cisco 300 Series switches come with advanced capabilities to conserve energy. This is becoming

more important as prices of energy rise, and electricity bills soar.

The 300 Series switches all have new advanced silicon, power supplies and fans that provide

significant power and energy savings. In addition, the switch provides 2 more capabilities of further

reducing power usage — powering down inactive ports, and adjusting the power usage based on the

cable length (available only on Gigabit models).

Scenario 1: Energy Detect Mode

STEP 1.

STEP 2.

On the menu bar, from the Port Management tab, drop down the Green Ethernet tab and
go to Properties.

The switch defaults to reserving power, however you can disable it through the
checkboxes in this menu.

Energy Detect Mode instructs the switch to significantly lower the power usage based on
the energy detected on the ports. If a port is not connected, or the PC connected to it is
shut down, that port will go into “sleep” mode and will wake up when it connected back
again.

Energy Detect Mode is available both on Fast Ethernet and Gigabit models.

Short Reach instructs the switch to adjust the power usage based on the cable length that
is used. Specifically, it will lower the power usage on connections that are using an
Ethernet cable that is 50 meters (164 ft.) or less.

Short Reach mode is available only in Gigabit versions of the switch.

% Note For this demo, notice that the Short Reach option is disabled at first. We will

demo it in the next scenario, where we will enable this option, and will
showcase the immediate savings this feature provides.

STEP 3.

STEP 4.

STEP 5.

Here you can see the Power Savings of the Switch, in milliwatts, since its last boot time
and the cumulative Energy saved in Watts/Hour.

Show that the switch has already saved 322 milliwatts, from the start.

In the Port Settings menu under Port Management, a list of the available ports will
appear with its energy saving attributes. Here you can see where the power savings are
coming from, and enable or disable the Energy Saving capabilities per port.

Notice that on port 1 (the port that your PC is connected to), the Energy Detect option is
disabled, as the switch is detecting energy on that port, so it cannot shut it down.

The Short Reach option indicates that the cable connected to port 1 is less than 50m, but
this option is disabled.
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Getting Started :
> Status and Statistics Port Settings
» Administration l Port Setting Table
‘ EntryNo. Port Energy Detect Short Reach
Port Settings Administrative  Operational Reason Administrative ~ Operational Reason ~ Cable Length
: :;‘:;wm o) 1 gl Enabled Disabled LinkUp  Enabled Disabled Less than 50m
+ Green Ethemnet O 2 g2 Enabled Enabled Enabled Disabled
Properti 0O 3 g3 Enabled Enabled Enabled Disabled
'ﬁ- uings| @) 4 g4 Enabled Enabled Enabled Disabled
» VLAN Management | O 5 g5 Enabled Enabled Enabled Disabled
> Spanning Tree O 6 g6 Enabled Enabled Enabled Disabled
» MAC Address Tables e 7 g7 Enabled Enabled Enabled Disabled
paliulicast O 8 g8 Enabled Enabled Enabled Disabled
» IP Configuration [ e ==
» Security

Scenario 2: Short Reach Mode

STEP 6. Go back to the Properties page to Enable the Short Reach option and click Apply.
Notice that this automatically increases the power savings to 417 milliwatts —a 95
milliwatt increase in savings, due to the short cable being used.

Energy Detect Mode: # Enable
Short Reach: # Enable
Power Savings: 417 milliwatts

cumuRive Energy Saved: 0 Watt Hour

STEP 7. Navigating back to the Port Settings page, you can see that the Short Reach option is
enabled because the switch has detected a connection that is less than 50m long.

Scenario 3: Power Savings Configurations per Port

STEP 8. You can apply Energy Saving abilities per port. In the Port Settings menu under Port
Management, a list of the available ports will appear with its energy saving attributes

Getting Started )
> s.a?:ma Statistics Port Settings
» Administral Port Setting Table
ort Managemen Entry No. Port = Energy Detect Short Reach
Port Settings Administrative | Operational Reason = Administrative = Operational Reason = Cable Length
:ﬂwgmm O 1 Enabled Disabled LinkUp  Enabled Disabled
+ Green Ethernet
Properties O 3 g3 Enabled Enabled Enabled Disabled
0 4 g4 Enabled Enabled Enabled Disabled
» VLAN Management O 5 g5 Enabled Enabled Enabled Disabled
> Spanning Tree 0 6 g6 Enabled Enabled Enabled Disabled
»MAC Address Tables (o) 7 o7 Enabled Enabled Enabled Disabled
hmdiulticast 0 8 o8 Enabled Enabled Enabled Disabled
» IP Configuration
e ( Copy Settings... | [ Edt.
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STEP9. Check the desired port to configure, and click Edit at the bottom of the page. A pop-up
block will appear where you will be able to set the Energy detection capabilities of that
port

Port: | g2 ~|

Energy Detect: @ Enable
Short Reach: @ Enable

- Apply| [ Close |

% Note When the Green Ethernet attributes of a port is changed, the link on that port
will go down momentarily, until it initializes with the proper settings.

Using Help

A context-sensitive Help menu is available, to help network administrators with configuration
information and general knowledge about the configuration options. This comes in handy when
guestions arise on on-site networking configuration options and possibilities.

During this demonstration it is important to showcase and underscore the ease-of-use, intuitive and
helpful management interface, and leadership compared to similar products.

Scenario 1: Accessing and Searching the Help pages
The Help Dictionary is accessible directly from the main configuration page and is always available, not

dependant on the page you are navigating to.

*:Save cisco Language: [ ITVTITINNST logout Abot Halp’

Clicking on this link will open up the Help dictionary, presented as an on-line book. You can navigate
through the chapters using the toolbar on the left hand side

Contents | Index & e i
Starting the Web-based Configuration Utility
DE?"‘"" Sz This section describes how to navigate the web-based switch configuration utlity.
e ey Browser Restrictions »
() Quick Start Switch Configuration
) Window Navigation Logging In»
> Viewing Statistics
> Managing System Logs
&> Managing System Files Logging Out »
<> General Administrative
Information and Operations

Password Expiration »

<> Port Management
<> Managing Power-over-Ethernet
Devices

> VLAN May
< Configuring the Spanning Tree
Protocol

<> Managing MAC Address Tables
< Configuring Multicast Forwarding
> Configuring IP Information

< Configuring Security

> Access Control

> Configuring Quality of Service
<> Configuring SNMP
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You can also search through the dictionary from the search bar.

In this demonstration we will learn more about IPv6. You can access the relevant files in a couple of

ways:

STEP 1.

If you already know that this information is under the Configuring IP Information menu, in

the Management and IP Interfaces page, we can simply go to that link and select one of
the many pages available on this topic.

Contents ! Index

&> Configuring Multicast
Forwarding

[1) Configuring IP Information
[11Management and IP

Interfaces

[£)Managing IPvG

> IP Addressing

[ Defining IPvG Global
Configuration

&1Defining an IPv6
| I‘I; l dLe

[Z Defining IPv6E Addresses

[ Defining an IPv6 Default
Router List

[Z Configuring IPv6 Tunnels

[ Defining IPvG Neighbors
Information

Defining an IPv6 Interface

The IPv6 Interfaces Page displays the switch’s IPv6 interface parameters and enables configuring this interface. An IPvG
interface can be configured on a port, a LAG, VLAN, or ISATAP tunnel interface. The switch supports one IPv6 interface
as an IPv6 end device.

Atunnel interface is configured with an IPv6 address based on the settings defined in the /Pv6 Tunnel Page.
To configure IPv6 interfaces:

1. In Layer 2 mode, click Administration = Management Interface = IPv6 Interfaces.
In Layer 3 mode, click IP Configuration > Management and IP Interface > IPv6 Interfaces.

The IPv6 Interfaces Page opens.
This page displays the IPv6 interfaces already configured.

2. Click Add to add a new IPv6 interface, that is to define on which interface IPv6 is enabled. The Add IPvé Interface
Page opens.
3. Enterthe values.

+ |Pv6 Interface—Select a specific port, LAG, VLAN, or ISATAP tunnel.

+ Number of DAD Attempts—Enter the number of consecutive neighbor solicitation messages that are
sent while Duplicate Address Detection (DAD) is performed on the interface’s Unicast IPv6 addresses.
DAD verifies the uniqueness of new Unicast IPv6 addresses before the addresses are assigned. New
addresses remain in a tentative state during DAD verification. Entering 0 in this field disables duplicate
address detection processing on the specified interface. Entering 1 in this field indicates a single
transmission without follow-up transmissions.

+ IPv6 Address Auto Configuration—Enable automatic address configuration from the DHCP server.
Address auto-configuration can be stateless or stateful (DHCP). If enabled, the switch supports IPv6
stateless address auto configuration of site local and global IP address from the IPv6 router

B VieWing |Pv6 Route advertisement received on the interface. The switch does not support stateful address auto configuration.
Tables + Send ICMPv6 Messages—Enable generating unreachable destination messages.
STEP 2. If you are unsure of where this info is located, a Search tool is available on the Help page

on its upper right hand side.

Search

STEP 3.

Typing in IPv6 will result in 36 different help topics, from which you can choose the most

appropriate topic for your situation. Selecting Defining an IP Interface will lead us to the
same exact page we navigated to manually, as in Step 1 of this demonstration.

Scenario 2: Context Sensitive Help — Accessing Help through Configuration

Another useful method of utilizing the Help menu is by accessing it during configurations. For

example, if you are in the midst of configuring the IPv6 interface, and are in need of additional

information on a line item or option, you can click the general Help link on the upper right hand side of

the management page, and the relevant Help page will appear.

STEP 4.

In the configuration bar on the left hand side go to the Administration menu,

Management Interface, then go to IPv6 Interface.
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STEPS5. Once you are in that page, click the Help link on the upper right hand side of the
management page, and the relevant Help page will appear. This will be the same page
that we navigated to manually on Step 1 of this demonstration.

Localization - Using different Languages to Manage the Switch

To ensure the globalization of the switch, the switch has been localized to 6 different languages. The
management interface, on-box help, and product documentation come in English, French, German,
Italian, Japanese and Spanish.

Any one of those languages can be downloaded to the switch, and will be available immediately for
use on the management and configuration pages and on-box help.

The language dictionaries are available either on the product’s CD or may be downloaded at

WWW.Cisco.com.

% Note Make sure that you have already downloaded a language file onto your PC’s
hard drive, the night before your presentation.

To make this presentation even more successful, download 2 language
dictionaries to your hard drive (for example: French and Italian), and show how
you can easily alternate between the two.

Here we will showcase the downloading of a language dictionary, enabling it, and viewing the
languages available on the switch.

During this demo, it is important to not only emphasize the ease of use and intuitive management
interface, but also the Globalization, and the availability of language that, to some people, could be
more intuitive.

Scenario 1: Viewing the Languages that are locally available
STEP 1. Navigate to the Status and Statistics menu, then to the System Summary page.
Here you will see the languages that are currently available on the switch. Notice that the
switch comes out-of-the-box with only English enabled.
Observe the languages listed under Locale, where you will see en-US (English).
STEP 2. If you have not already installed a second language, the second entry under Locale will not
be populated.

Scenario 2: Uploading a New Language onto the switch
STEP 1. The easiest method of downloading a new language is by utilizing the Language link at the
top right hand side of the management page. If you drop down that menu, you will see
the available languages already installed.
In this example, English is available as the default language and Italian as a second.
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STEP 2.

STEP 3.

clsco  Lingua: ([FISm——mmmmggry Esci informazionisu  Guida

English
Itallano
s Download Language %

Select Download Language at the bottom of the menu. This will lead you to the
Upgrade/Backup Firmware/Language page.

You can alternatively go into Navigate to Administration menu, then File Management
page and select Upgrade/Backup Firmware/Language.

Select via HTTP as Transfer Method, and Upgrade as Save Action. Select Language as File
Type as this is the file type you will be downloading. Click Browse to locate the Language
file on your management PC’s hard drive.

In this example, we will upgrade French as a second language.

Upgrade/Backup Firmware/Language

Transfer Method: () via TFTP
@ viaHTTP
—006 File Upload .
SEE Al ? s (<« » (58 = m) [(I5x300 Dictionary fr-FR___ 3] Q
File Type: () Firmware Image ¥ DEVICES T{ dict_fr.xml | ¥ Preview: 2
O Boot Code = Macintosh HD | emb_dictionary_fr.xml M
© Language Fie B o
# File Name: | ( Browse... ) S CTIARED
The is L to the inactive image file. You must activate| (™ All...
¥ PLACES
w [ Cancel ] A Desktop
— Name Sx300_LANG_fr_FR_
7 Applications 1.0.0.5.lang
[} Documents Kind Unix Executable &
File
¥ SEARCH FOR Size 496 KB on disk
(L) Today Created 05/21/10 s
(© Yesterday s 1 Modified 05/21/10 M
(L) Past Week MEL ([ L
"] Hide extension
A'
STEP 4. Once the upload is complete, you will get a success indication message.
Getting Started .
— Upgrade/Backup Firmware/Language
dministratic Bytes Transferred: 494293
System Settings Status: Copy finished
» Management Interface Error Message:
User Accounts
" mane
Idle Session Timeout - Done
» Time Settings
» System Log
v File Management
Upgrade/Backup Firmware/Language
Artive Imana
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STEP 5. Once the download is complete, notice that the new languages you have downloaded is
available on the switch

Scenario 3: Starting to Use the New Language

STEP 1. Once you have downloaded a new language onto the switch, it is easy to begin using it.
From the Language drop down menu on the left hand side, select the language you want
to use.

STEP 2. Upon selection, the language will be changed on the fly - all menu items and dictionary
will be using your selected language, as seen in the screen shot below.

Frangais
Download Language

all B € egistre SCO angue F[angais v e déconnecte A propos de  Aide
- 00-10P Co ateur ad able 10 po gabit Po
» Etat et statistiques Avant ae co chce
» Administration
> Gestion des ports Cette page indique les étapes a suivre pour configurer aisément votre appareil.
» Gestion des VLAN
» Spanning Tree “ Configuration initiale ¢ Accés rapide
»
idblestadiensesMAG Modifier 'adresse IP de Iappareil Modifier le mot de passe de 'appareil
> Multidiffusion . . . ;
- Créer un VLAN Mettre a niveau le logiciel de I'appareil
» Configuration IP
> Sécurite Configurer les paramétres de port Configuration de sauvegarde de I'appareil
> Contrdle d'accés Créer une ACL basée sur MAC
e : il Etat de l'appareil - -

> Qualité de senvice Ullg pp Créerune ACL basée surIP
» SNMP Récapitulatif du systéme Configurer la QoS

Statistiques des ports Configurer la mise en miroir des ports

Statistiques RMON

Afficher le journal

Autres ressources: Assistance | Forums
" Ne pas afficher cette page au démarrage
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Advanced Demo

In this set of demonstrations we will showcase some of the advanced features that the 300 Series
switches has to offer. This will require a slightly different setup than the Basic demo scenarios, which
we have shown before, and additional equipment.

% Note Please ensure that you have all the equipment necessary to complete your
demonstration. Please refer to the Bill of Materials at the beginning of this
document

Device Setup

STEP 1. Leave your Management PC as you have it connected from the Basic demonstration, and
keep the IP address as is (192.168.1.25 in this example).

STEP 2. Connect an Ethernet Cable from the Ethernet port of your other PC (PC2) to Port 5 of the
switch’s Ethernet Port. The LEDs on the connected Port should become green to note the
Port is operational.

*  Port5is given as an example, but you can alternatively connect the cable to any other port

on the switch.

STEP 3. Configure PC2’s IP address to 192.168.1.30, so it will be on the same subnet as the switch and
your management PC.

Your network Topology should look like this:

“Advanced” Demonstration Design

PC 1 PC 2
Management PC ’ ’
192.168.1.25 /24 192.168.1.30 /24

300 Series Switch
192.168.1.254 /24
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Virtual LANs (VLANSs)

To optimize network application performance and security, end-stations (users) that have common
attributes or, for example, belong to the same group within the organization, can be grouped together
to create one sub-network even if they are not physically on the same network. This segregation of
subnets creates logical networks, which do not interfere one with the other, therefore increasing
optimization of the network bandwidth and company productivity.

This grouping is called a Virtual LAN (VLAN), and is used widely within organizations’ networks.

For example: you can group together your Sales and Marketing team into one VLAN and group the
Accounting team into another, so traffic will flow seamlessly in-between these groups, and not
interfere with one another.

The 300 Series switch fully manages the Virtual LANs — their administration through an easy
configuration menu, and their traffic in a seamless manner without hindering on traffic performance,
while providing wire-speed traffic. Moreover, since users/ports are grouped together, regardless of
their physical location, this reduces the need for additional routers on the network, thereby providing
significant savings. In addition, VLANs provide further security by reducing router hops and Broadcast
traffic on the complete network.

This feature provides not only cost reduction, but also significantly increases the performance and
safety of your network, and is easily managed and administered in the 300 Series switches.

In this demonstration, we will show how to easily Create a VLAN, Assign a port to the VLAN, Test the
VLAN functionality and also how to use Layer 3 mode, the latter being an Advanced option.

Remember to showcase and focus on the key attributes of this feature and the benefits of the 300
Series switches:

Ease of use

Intuitive Management Interface
- Cost Savings

Routing Functionality

In this demonstration, we will show how the Management PC and PC2 can communicate effectively
when they are both on the same IP subnet, and using the same VLAN, which is the default
management VLAN.

However when PC2 is configured to use a different VLAN, they cannot communicate between each
other, although they are physically connected to the same switch.

This demo will take you through this process step-by-step.

%‘ Note If you do not have access to another PC, you can a camera instead of PC2, as
stated in the BOM. The demo will work exactly the same.
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% Note This demonstration is equivalent to a real scenario, in where the Sales and
Marketing group use VLAN 1 and the Accounting team uses VLAN 10. Random
traffic will not flow between the two groups and will not interfere one with the
other.

Scenario 1: Creating VLANs

STEP1. On the menu bar, drop down the VLAN Management tab and select Create VLAN.
Alternatively, you can reach this window by clicking the Create VLAN link in the Getting

Started page.

%‘ Note VLAN 1is created by default for data and management traffic. For stability
reasons, please DO NOT delete this VLAN.

STEP 2. Click the Add button. A new window will appear to create a new VLAN.
Type in 10 in the VLAN ID space and click Apply.
STEP3. A Success icon will appear on the top to indicate your previous creation took effect

g Success.

STEP4. Ensure that the VLAN you created is visible on the Create VLAN page.

Create VLAN
VLAN Table
VLANID VLAN Name Type
1 Default
0) 10 Static
Add...

Scenario 2: Assign a VLAN to a port
STEP5. In the VLAN Management tab, select Interface Settings
All the available interfaces of the switch will appear in a list.
Select el (or g1 in Gigabit switches) and click Edit at the bottom of the page. This will
configure Port 1.
STEP6. Set Interface 2 to Access, and click Apply
Repeat the same procedure for Port 5 (e5/g5).

% Note Trunk is the default setting for the Interface VLAN Mode, and represents a case
where multiple VLANs are passing through that port.

In case this interface will include more than one VLAN, its mode will have to be
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returned to Trunk. This will be the case when connecting Cisco Small Business IP
Phones, such as SPA5xx or SPA3xx family, as these natively use a dedicated
VLAN to differentiate and prioritize their traffic.

STEP 7.

Scenario 3:
STEP 8.

STEP 9.
STEP 10.

STEP 11.

STEP 12.

Test that there is connectivity between the 2 PCs, using a ping command:

On your management PC, open a command line prompt, and ping PC2’s IP address as
follows:

ping 192.168.1.30

Notice that ping queries are answered, and that connectivity is in place between the 2
devices.

From PC2 you can use a ping command to PC1’s IP address, to verify bi-directional
connectivity.

ping 192.168.1.25

Notice that ping queries are answered, and that connectivity is in place between the 2
devices.

Testing VLAN Functionality

In the VLAN Management tab, select Port to VLAN

All the available interfaces of the switch will appear in a list, including its mode and
associated VLANs. Notice that el and e2 are set to Access.

Filter via VLAN ID 10 and click Go.

Check the PVID box on port 5, and click Apply.

| ———
Getting Started
» Status and Statistics Port to VLAN
» Administration
T e— Fiter. VLANID equalsto |10 ~| AND Interface Type equaisto |Port ~| | Go |
Interface g1 g2 @3 g4 g5 g6 g7 g8 g9 g10
Default VLAN Settings ACCOSS
Create VLAN Trunk
Interface Settings -
eneral
VLAN to Port Forbidden (
Port VLAN Membership Excuded ® ® ® ® O ® ®@ ® ® O
GVRP Settings Tagged - J O O C
» VLAN Groups Untagged Y ® 0O 0O O (
» Voice VLAN PVID .
» Spanning Tree e s R
a=MAGAdRGS ating lApply.i | Cancel || Port VLAN Membership Table |
» Multicast

Click on Port VLAN Membership Table at the bottom of that page. This will lead you to
the Port VLAN Membership page on the VLAN Management menu.
Here we will see that Port 5 is now a member of VLAN 10,as you have just configured it.

Now that the 2 ports are members of 2 different VLANSs, let’s test connectivity between
the two devices.

Repeat Step 7 to test connectivity between the 2 PCs, through a ping test.

Notice that communication between the two devices have ceased, and packets cannot
flow through between them, although they are physically on the same switch.
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Scenario 4: Optional Inter-VLAN routing exercise utilizing layer 3 mode

This demonstration will focus on the switches’ Routing capabilities.

This is a true differentiator for the 300 Series switches, as many competitive products do not share
this functionality.

Moreover, the benefit for the end-user is huge as it saves the extra cost of purchasing additional
routers, thereby saving cost for the typical business owner.

In this demonstration, we will show that 2 PCs that are physically connected to ports of the same
switch can be assigned not only different Virtual LANs, but also different IP addresses, and behave as if
they are on physically separate subnets. The switch routes between the 2 subnets, seamlessly,
without disruptions.

We will assign IP addresses in different subnets to our Management PC (PC1) and to PC2, the following
manner.
The network topology for this demo should look like this:

“Advanced” Demonstration Design

PC 1
Management PC ’
1.1.1.10/24 10.1.1.10 /24
VLAN 1 VLAN 10

300 Series Switch

1.1/24 -VLAN 1

1.1
10.1.1.1 /24 - VLAN 10

Activating Menu CLI

You will need to utilize the Menu CLI to enable the Layer 3 functionality of the switch.
To do so, follow the following steps:

STEP 1. First, you will need to enable Layer 3 Functionality in the switch.
This can be done only through the configuration Menu in CLI.

STEP 2. To do this, connect the switch to your PC via the serial cable and open a Terminal
application (HyperTerminal for Windows users)

STEP 3. Verify that the correct Terminal settings apply to your Terminal application, as following:
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STEP 4.
STEP 5.

STEP 6.
STEP 7.

Data Rate: 115200
Date Bits: 8
Parity: None

Stop Bits: 1

Once the connection is established, enter the switch’s Menu CLI screen.

Switch Moin Menu

1. System Configurotion Menu_

~N

. Port Stotus

3. Port Configuration

'.{.

System Mode
5. Help

@. Logout

Navigate using the down arrow button to System Mode and click Enter.

Navigate to Edit using the right arrow button. This will enable you to change the system
settings, and will revert the prompt to the editable values.

Use the space button to change the configuration from Layer 2 to Layer 3.

Hit the Esc button, then right arrow to Save, then typeinY.

The switch will immediately enter Layer 3 mode.

%‘ Note Changing the Routing mode of the switch as described above will reset the

previously working settings of the switch, and all configurations done thus far
will be eliminated.

You will also need to go back and recreate VLAN 10, and assign it to Port 5, as
you’ve done in the previous demonstration.

Inter-VLAN Routing Demonstration using Layer 3 Mode

STEP 1.

Launch a browser and connect to the management user interface of the switch, as we
have done throughout the Basic demonstrations.

%‘ Note Since the previous configurations were reset, log in with the default username

and password: cisco and Cisco.

You will be prompted again to change your password.

STEP 2.

Create VLAN 10 and assign it to Port 5, as you did in the previous demonstration. Repeat
Steps 1-11 of the previous demo.
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% Note Notice that the IPv4 Configuration page is slightly different, now that Layer 3 is
enabled. It now lets you configure multiple IP Interfaces, whereas In the Basic
demo, we could modify only one IP Address to the switch.

STEP 1. Create the IP interfaces for VLAN 1 and VLAN 10. We will assign the following:
1.1.1.1to VLAN 1

10.1.1.1 to VLAN 10

STEP 2. Navigate to IP Configuration menu and go into IPv4 Interface.
Notice that the Interface that is saved for an address obtained by DHCP is present in the
list. We will not need this interface, so it is advisable to delete it.
To do so, simply click that entry and choose Delete.

IPv4 Interface

IPv4 Interface Table

Interface  IP Address Type IP Address Mask Status
v

VLAN 1 Default 192.168.1.254 255.255.255.0 Valid

Add.. | bges |

STEP 3. Add the interfaces discussed above, by clicking Add and applying the following
information:
IP Address Type: Static IP Address
IP Address: 1.1.1.1
Mask: 255.255.255.0
VLAN: 1

Interface ) Port | ~ OAG [T =] ® vian [1 +]

IP Address Type: () Dynamic IP Address
® Static IP Address

IP Address: ‘*1

Mask @ Network Mask |255.255.255.0]
Prefix Length

%‘ Note Connectivity to your PC will stop once the IP address has changed.

STEP 4. Change the static IP address of your Management PCto 1.1.1.10.
Configure the Default gateway to 1.1.1.1, which is now the address for VLAN 1 on the
switch.
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STEP5. Ensure that communication has been restored to the switch. You can test this through a
simple ping test from a command line window.

STEP 6. Access the switch’s web management interface through the new IP address assigned. In
your web browser, type in
http://1.1.1.1

STEP 7. Go back to the IPv4 Interface page (in IP Configuration menu) and notice that the new
interface for VLAN 1 has been changed to 1.1.1.1.

STEP 8. Create another IP Interface for VLAN 10. Follow steps 5-9 of this demo, using the following
data:

IP Address Type: Static IP Address
IP Address: 10.1.1.1

Mask: 255.255.255.0

VLAN: 10

Change PC2’s IP Address to 10.1.1.10
STEP 9. Navigate to IP Configuration menu, then to IPv4 Static Routes.
In this page you can see the new Static IP Addresses that were created.

IPv4 Static Routes

IPv4 Static Routing Table

AQdress Prefix Length  Next Hop Router IP Address Route Type Route Owner Maetric
24 Local

24 Local

Destination TP
1.1.1.0
10.1.1.0

STEP 10. Now let’s test connectivity between the 2 PCs, that are on different IP subnets.
From a command prompt on PC1 (1.1.1.10), ping the following address and verify that
communication is successful:
Ping 1.1.1.1
- this verifies communication with VLAN 1 IP address of the switch
Ping 10.1.1.1
- this verifies communication with VLAN 10 IP address of the switch, basically showing
the switch can route via Layer 3 IP communication
ping 10.1.1.10
- this is PC2’s IP address. This verifies successful communication between both PCs, and
that routing is present.

You can conduct the same verifications from PC2, to ensure proper bi-directional
communication.

This demo basically shows that 2 separate networks were created, without the use of a router, This
type of scenario becomes especially useful when a business network is growing rapidly and a new user
can’t easily be assigned a physical port that is close to its network.

Moreover, in collaboration projects, where much traffic is generated within groups, VLANs provide an
easy method of segregating traffic within a working group, thereby not interfering with other working
groups within the company.
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This also protects against security threats, such as sensitive information being broadcasted on the
network. In this case, only qualified viewers will be able to see this information.

Multicast

IP Multicast is a technique used for one-to-many communication in a network. The IGMP protocol,
which implements Multicast is typically used for streaming media and IP-based television. While the
latter is more applicable to residential networks, the former is commonly used in Small Businesses, for
example: businesses that conduct learning courses for many participants, or communicate messages
through video.

IGMP snooping is a powerful tool for energy and bandwidth conservation, as it requires the
transmitter to send a packet only once, even if the media is delivered to many “listeners” (or
“viewers”). Since the viewers are required to “register” for the streaming media service, packets are
sent only to those registered ports. This powerful tool can be enabled in the switch, thereby realizing
significant cost savings in bandwidth, CPU and energy consumption.

Scenario 1: Streaming a Video from a Source to Many Receivers

This demo shows how easy it is to setup IGMP in the 300 series switch, which reduce the energy, CPU
and bandwidth consumption when streaming media. We will show how, without IGMP settings
packets are being sent to all ports, while with IGMP settings packets are sent only to the “listeners” of
that stream.

The setup will look like this:

“Advanced” Demonstration Design

PC 1 PC 2
Management PC ’ ’
192.168.1.25 /24 192.168.1.30 /24
VLAN 1 VLAN 1

300 Series Switch
192.168.1.254 /24
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STEP 1.

STEP 2.

STEP 3.

STEP 4.

Ensure that you have 2 PCs connected to your switch, as shown in the figure above, along
with an Ethernet cable connected between two other ports on the switch. This will
simulate 2 other active users on the network.

PC1 (Video Streaming Client) is connected to portl

PC2 (Video Streaming Server) is connected to port8

Ethernet Cable is connected between port6 and port7

Ensure that VLC software version 0.8.6h is installed on both PC1 and PC2

We will be using multicast address 225.5.5.5 and VLAN 1 as our multicast streaming
address and VLAN

Check the status of the switch through the Status and Statistics > System Summary page.
Notice that there is connectivity on ports 1, 6, 7 and 8.

Ensure that ports 1, 6, 7 an 8 are set for VLAN 1. Go to VLAN Management > Port VLAN
Membership to view a list of ports and their corresponding VLANs

Setting up VLC Video Streaming Server

STEP 5.
STEP 6.

STEP 7.

STEP 8.

STEP 9.
STEP 10.
STEP 11.

Insert a DVD movie into PC2’s DVD drive and launch the VLC application.

In File menu, select Wizard. The Streaming/Transcoding Wizard appears. This will go
through the setup of streaming a video from PC2 to the network.

Select Stream to Network, and click Next. The Input screen will appear. Select Choose
under Select a Stream, and specify the source of the video you will be using. In this case it
will be your local CD player. Go to Disc tab and select DVD, keep all other default settings
as they are. Click OK, and then click Next.

Next we must tell the server how to stream the video.

As mentioned in Step 2, we will be using multicast address 225.5.5.5 for this
demonstration.

Select RTP Multicast and enter 225.5.5.5 in the Destination window. Then click Next.

In the Encapsulation format screen, select the default MPEG-TS and click Next

Click Finish and exit VLC wizard

You should now hear your CD player start to spin, and you are now streaming to 225.5.5.5

Setting up VLC Video Streaming Client

STEP 12.

STEP 13.

STEP 14.

We will now setup PC1 to receive the video stream.

Open the VLC application. Go to the File menu, then select Open Network.

In the Network tab, select the UDP/RTP Multicast radio button and in the Address field
insert the multicast address that PC2 is streaming the video on — 225.5.5.5.

Click Ok and the stream will start to play

Scenario 2: IGMP Snooping

We will now show how multicast and IGMP snooping application on the 300 Series switch saves

valuable resources.

The switch’s default configuration is Multicast disabled. On the switch’s front panel, show how this
configuration sends traffic to all available ports, even the ones that are not viewing this video, thereby

spending valuable resources. You can see this by showing how ports 6 and 7 (which are connected to

each other and simulate 2 additional hosts) light up to show activity.
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STEP 15. We will now enable Multicast to correct the default behavior.
In the Multicast menu, go to Properties.
Enable Multicast by checking the Bridge Multicast Filtering Status field.
Under Forwarding Method for IPv4 select IP Group Address
Ensure that VLAN 1 is selected for Multicast VLAN ID
Click Apply

STEP 16. Next go to IP Multicast Group Address. Click Add.

STEP 17. Enter the following into the information pop-up window:
VLAN ID: 1
IP Multicast Group Address: 225.5.5.5
Click Apply, then Close

STEP 18. Now we will configure IGMP Snooping for the switch to monitor network traffic and to
determine the relevant ports to which to send the multicast traffic, thus saving valuable
resources.
Go to IGMP Snooping. Enable IGMP Snooping Status and click Apply

STEP 19. In the same window, select the radio button for VLAN 1 and click Edit.

STEP 20. In the window opened, enable the IGMP Snooping Status and leave the rest at rest at
default. Click Apply, then Close

STEP 21. Go to IGMP/MLD IP Multicast Group menu and notice that our configured IP multicast
address with VLAN 1 has been added as an entry.

STEP 22. Go back to look at the status LEDs in the front panel and notice that only ports that have
registered for this video stream are lit up, and those that have not (i.e. the idle ports 6 and
7) are not getting any traffic sent to them. This basically saves the bandwidth on ports that
are not requesting this video.

Security - Access Control Lists

This demonstration focuses on the security aspect of the 300 series switch. As the switch is an integral
part of the Small Business network, it provides means for communications and running important
applications. But keeping the network secure is an integral part of a Small Business day-to-day life.
The 300 series switch includes a wide variety of security features that addresses these security
concerns, such as Denial of Service (DoS), Physical Port Security, Management Authentication
methods, Access Control and 802.1x, to name a few. This list of features further stresses the
superiority of the 300 series switch over competitive products, while providing an enhanced feature-
set at a competitive price.

This demonstration focuses on Access Control, a method of controlling the traffic that enters the
switch, thereby acting as a filter to deny and/or allow traffic on certain ports to pass through.
We will go through the following steps, which will ultimately showcase how security is enabled:

1. Create an Access Control List (ACL)

2. Create an Access Control Entity (ACE), which is bound to an ACL

3. Bind the ACL to an interface

4. Show how the Access Control rules we’ve created come into action

We will show how a video stream that is already passing from 1 port to another, will be denied to pass
through, once Access Control is applied and bound to the streaming port (that which is connected to
the streaming “server” — see setup below), therefore securing the local Small Business network.
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Remember to showcase and focus on the key attributes of this feature and the benefits of the 300

Series switches:

- Ease of use
- Intuitive Management Interface
- Feature richness and market leadership

The setup is the same as in the previous demonstration — Multicast, as we will utilize the video
streaming functionality that has already been set up. Note that the Ethernet cable that was plugged in
to ports 6 and 7 will not be needed in this demonstration, and should be plugged out.

The setup should look like this:

“Advanced” Demonstration Design

Video Stream “Client” Video Stream "Server’

PC 1 PC2
Management PC ’ ’
192.168.1.25 /24 Multicast Group 192.168.1.30 /24
Address
VLAN 1 2066555 VLAN 1

300 Series Switch
192.168.1.254 /24

STEP 1. As you have done in the previous demonstration — multicast, begin to stream video from
the Video Streaming “Server”, connected to port 8, to the Video Streaming “Client”
connected to port 1. Verify that you can see the video well on the receiving end.

Create an Access Control List (ACL)

STEP 2. Log into the switch’s management interface and navigate to Access Control.
Show how you have the option to create ACLs and ACEs based on Layer-2 or Layer-3
address or protocol elements, including IPv6.

STEP 3. Go to IPv4-Based ACL, and click Add

STEP 4. Enter a name for this Access Control List in the ACL List window. Enter a name that is
relevant to the operation you will be configuring, such as “DenyAll”. Note that many ACLs
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STEP 5.

can be configured at any given time, therefore it’s important to differentiate your ACL
name so you will remember its functionality.
Click Apply, then Close

Create an Access Control Element (ACE)

STEP 6.

STEP 7.
STEP 8.

STEP 9.

STEP 10.
STEP 11.

STEP 12.

Once the ACL has been created, you will return to the IPv4-Based ACL page, where you
will find a shortcut to create an ACE for the ACL you’ve created - IPv4-Based ACE.
Show how intuitive the management interface is, such that it helps the user not forget
important configuration items and guides the user through the process, by providing
shortcuts and guidance.

Click on the IPv4-Based ACE button, or go to the IPv4-Based ACE link in the menu bar.
The IPv4-Based ACE page appears. Ensure that the ACL you are filtered on is DenyAll.
Notice that there are no ACEs configured.

Click Add to create a new traffic filter for the ACL we have just created

The ACE page appears. Notice that the ACL name is DenyAll.

We will assign to this ACE attributes that filter all incoming traffic into a given port.
Assign the following values to this page:

Priority: 1

Action: Deny

Protocol: Any

Source IP Address: Any

Destination IP Address: Any

Type of Service: Any

Click Apply, then Close to save your ACE

You will return to the IPv4-Based ACE page, where the ACE you’ve created will appear in
the designated rows.

Bind the ACL to an interface

STEP 13.

STEP 14.

Now that we’ve created the elements in which we will control traffic, we will bind it to
port 8, which is the video streaming server.

Go to ACL Binding and select port 8. Click Edit

Check the Select IPv4-Based ACL checkbox, and select the ACL you want to bind the port
to. In our case there is only one option and that is DenyAll

We will apply these changes in the next section, when we will see Access Control List in
action. Keep this window open.

Show the Access Control List in Action

STEP 15.
STEP 16.

STEP 17.

STEP 18.

Go back to watching the video you are streaming, on PC1 — the Video Streaming “Client”.
Now revert to the switch’s management interface and click Apply on the ACL Binding
window. You will be returned to the ACL Binding page, where you can see that port 8 is
bound to the ACL DenyAll

Show how the video has stopped on the receiving end, the moment the ACL was bound to
port 8. This filter basically blocks anything from entering this port

Now let’s un-bind the ACL from port 8 and see how the video continues to flow.

Click the port 8 checkbox and click Clear.
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This will essentially allow all traffic that was blocked to flow through once more through
the switch.

The movie that was stopped, upon creation of a ACL, will continue to stream once more
once that ACL is un-bound from that port.

Quality of Service

Coming soon....

39



